SIMATIC

Industrial PC
SIMATIC IPC Wizard 2.1 and Panel Configuration Center

Operating Manual

07/2014
A5E34984843-AA
Legal information

Warning notice system

This manual contains notices you have to observe in order to ensure your personal safety, as well as to prevent damage to property. The notices referring to your personal safety are highlighted in the manual by a safety alert symbol, notices referring only to property damage have no safety alert symbol. These notices shown below are graded according to the degree of danger.

![DANGER](image)
indicates that death or severe personal injury will result if proper precautions are not taken.

![WARNING](image)
indicates that death or severe personal injury may result if proper precautions are not taken.

![CAUTION](image)
indicates that minor personal injury can result if proper precautions are not taken.

![NOTICE](image)
indicates that property damage can result if proper precautions are not taken.

If more than one degree of danger is present, the warning notice representing the highest degree of danger will be used. A notice warning of injury to persons with a safety alert symbol may also include a warning relating to property damage.

Qualified Personnel

The product/system described in this documentation may be operated only by personnel qualified for the specific task in accordance with the relevant documentation, in particular its warning notices and safety instructions. Qualified personnel are those who, based on their training and experience, are capable of identifying risks and avoiding potential hazards when working with these products/systems.

Proper use of Siemens products

Note the following:

![WARNING](image)
Siemens products may only be used for the applications described in the catalog and in the relevant technical documentation. If products and components from other manufacturers are used, these must be recommended or approved by Siemens. Proper transport, storage, installation, assembly, commissioning, operation and maintenance are required to ensure that the products operate safely and without any problems. The permissible ambient conditions must be complied with. The information in the relevant documentation must be observed.

Trademarks

All names identified by ® are registered trademarks of Siemens AG. The remaining trademarks in this publication may be trademarks whose use by third parties for their own purposes could violate the rights of the owner.

Disclaimer of Liability

We have reviewed the contents of this publication to ensure consistency with the hardware and software described. Since variance cannot be precluded entirely, we cannot guarantee full consistency. However, the information in this publication is reviewed regularly and any necessary corrections are included in subsequent editions.
Preface

Purpose

This document is part of the documentation of SIMATIC IPCs. The document contains the following information:

- Using the SIMATIC IPC Wizard for widescreen devices
- Installation and use of the Panel Configuration Center

Conventions

The following abbreviations of product names are used in this document:

<table>
<thead>
<tr>
<th>Long form</th>
<th>Abbreviation</th>
</tr>
</thead>
<tbody>
<tr>
<td>SIMATIC IPC Wizard for Widescreen Devices</td>
<td>IPC Wizard</td>
</tr>
<tr>
<td>SIMATIC IPC, SIMATIC BoxPC, computer</td>
<td>PC</td>
</tr>
<tr>
<td>SIMATIC IPC, SIMATIC IFP</td>
<td>Device</td>
</tr>
<tr>
<td>SIMATIC IPC touch/key, SIMATIC IFP Touch/Key</td>
<td>Keyboard unit</td>
</tr>
<tr>
<td>Windows Embedded Standard 7E, 7P</td>
<td>WES7E, WES7P</td>
</tr>
<tr>
<td>Windows 7 Ultimate</td>
<td>Windows 7</td>
</tr>
<tr>
<td>SIMATIC IPC Single-touch, SIMATIC IFP Touch, Touch/Key</td>
<td>Devices with resistive single-touch screen</td>
</tr>
<tr>
<td>SIMATIC IPC Multi-touch, SIMATIC IFP Multi-touch</td>
<td>Devices with capacitive multi-touch screen</td>
</tr>
<tr>
<td>SIMATIC IFP Monitor</td>
<td>Monitor</td>
</tr>
<tr>
<td>Panel Configuration Center</td>
<td>PCC</td>
</tr>
</tbody>
</table>

Style conventions

<table>
<thead>
<tr>
<th>Style convention</th>
<th>Scope</th>
</tr>
</thead>
</table>
| "Add screen"     | - User interface terms, for example, dialog names, tabs, buttons, menu commands
|                  | - Required inputs, for example, limits, tag values.                  |
|                  | - Path information                                                   |
| "File > Edit"    | Operator actions, for example, menu commands, shortcut menu commands. |
| <F1>, <Alt+P>    | Keyboard operation                                                   |

Figures

This document contains images of the software described. The images can deviate slightly from the supplied software.
Trademarks

The following designations marked with the symbol ® are registered trademarks of Siemens AG:

• SIMATIC®, SIMATIC HMI®, SIMATIC Industrial Flat Panel®, SIMATIC IPC®
• WinCC®

History

<table>
<thead>
<tr>
<th>Edition</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>07/2014</td>
<td>First edition</td>
</tr>
</tbody>
</table>
Table of contents

Preface ........................................................................................................................................... 3
1 IPC Wizard .................................................................................................................................... 7
   1.1 Product description ................................................................................................................... 7
   1.2 System requirements .................................................................................................................. 7
   1.3 Setup ......................................................................................................................................... 9
   1.3.1 Installing IPC Wizard .......................................................................................................... 9
   1.3.2 Changing, repairing, or uninstalling the IPC Wizard ......................................................... 10
   1.3.3 Software components (features) ......................................................................................... 12
2 Panel Configuration Center (PCC) ............................................................................................ 13
   2.1 Product description .................................................................................................................... 13
   2.2 Overview ................................................................................................................................ 13
3 Software description .................................................................................................................. 17
   3.1 General for all devices .............................................................................................................. 17
   3.1.1 Panel PC Tools ..................................................................................................................... 17
   3.1.1.1 SetBrightness .................................................................................................................. 17
   3.1.1.2 IPCScreenSaver .............................................................................................................. 19
   3.2 Special for devices with resistive single touch screen ............................................................ 22
   3.2.1 Universal Pointing Device Driver (UPDD) ......................................................................... 22
   3.2.1.1 Overview UPDD Console .............................................................................................. 22
   3.2.1.2 Notes on clone mode ...................................................................................................... 24
   3.2.1.3 Calibrate touch screen .................................................................................................. 24
   3.2.1.4 Touch functionality ........................................................................................................ 27
   3.3 Special for devices with capacitive multi-touch screen .......................................................... 31
   3.3.1 Interlock in clone mode ....................................................................................................... 31
   3.3.1.1 Notes on clone mode ..................................................................................................... 31
   3.3.1.2 Activating the interlock mechanism ............................................................................ 31
   3.3.2 SIMATIC Switch Touch Mode ............................................................................................. 32
   3.3.2.1 Overview ...................................................................................................................... 32
   3.3.2.2 Toggling Switch Touch Mode ...................................................................................... 33
   3.4 Special touch/key devices ....................................................................................................... 34
   3.4.1 KeyToolsPhone .................................................................................................................... 34
   3.4.1.1 Overview ....................................................................................................................... 34
   3.4.1.2 Clone mode .................................................................................................................... 35
   3.4.1.3 Operating the KeyToolsPhone ..................................................................................... 38
   3.4.1.4 Language selection for key devices ............................................................................. 54
   3.4.2 PhoneKeyPad ...................................................................................................................... 58
   3.4.2.1 Overview ...................................................................................................................... 58
   3.4.2.2 Clone mode .................................................................................................................... 58
A Technical support .................................................................................................................... 59
   A.1 Service and support ................................................................................................................ 59
Index ................................................................................................................................................ 61
1.1 Product description

SIMATIC IPC Wizard for SIMATIC Industrial PCs installs device-specific software and drivers for operating your PC. These software components enable you to set the screen of your SIMATIC device, for example, the brightness.

The SIMATIC IPC Wizard recognizes the existing hardware components and automatically installs the associated software.

- SIMATIC Industrial PCs with preinstalled software contain the SIMATIC IPC Wizard that runs automatically during initial commissioning.
- On SIMATIC Industrial PCs without preinstalled software, you can install the SIMATIC IPC Wizard from the CD/DVD "Documentation and Drivers" on which the documentation of the SIMATIC IPC Wizard is located.

1.2 System requirements

Hardware requirements

For the SIMATIC IPC Wizard you require the following hardware:

- PC with connected SIMATIC display: e.g. SIMATIC Panel PC or PC with connected SIMATIC Industrial Flat Panel
- 650 MB of free hard disk space on the PC, C:\ partition
- The SIMATIC IPC display is fully connected:
  - DVI / DP connection for video signals
  - USB connection for touch signals

Note

Connected devices

The SIMATIC IPC Wizard does not support the combination of devices with resistive single-touch screen and capacitive multi-touch screen.

Note for SIMATIC Industrial Flat Panels:

- If you use a SIMATIC Industrial Flat Panel with the PC, connect the Industrial Flat Panel to the PC before initial commissioning.
- During initial commissioning, multiple Industrial Flat Panels may be connected to the PC.
1.2 System requirements

Supported operating systems

The SIMATIC IPC Wizard on PCs runs with the following operating systems:

- Microsoft Windows 32-bit operating system
  - Windows 7 Ultimate with SP1
  - Windows Embedded Standard 7E ¹ or 7P with SP1
- Microsoft Windows 64-bit operating system
  - Windows 7 Ultimate with SP1
  - Windows Server 2008 R2
  - Windows Embedded Standard 7E ¹ or 7P with SP1

¹ For devices with capacitive multi-touch screen, WES7E is only supported in single-touch mode (see section "Toggling Switch Touch Mode (Page 33)").

Software requirements

- One of the operating systems named in "Supported operating systems" section is installed.
- The driver of the device manufacturer for the graphics adapter is installed.
- The installed graphics driver supports reading of EDID data from the screen.

Note

The Microsoft VESA driver is not supported by the SIMATIC IPC Wizard.
Setup cancels the installation.
1.3 Setup

1.3.1 Installing IPC Wizard

Requirement

- The system requirements (Page 7) are met.
- Do not apply with factory state: If following previous driver versions exist, uninstall them via "Start > Control Panel > Programs and Features":
  - IPC Wizard V1.0
  - IPC Wizard V2.0
  - IPC Switch Touch Mode V2.0.5

Procedure

1. Turn on the PC.
   - With the factory state of some IPCs, the SIMATIC IPC Wizard is pre-installed. The installation starts the first time the PC is switched on.
   - If your SIMATIC IPC was delivered without pre-installed software, start the installation of the SIMATIC IPC Wizard from the "Documentation and Drivers" CD/DVD. Select the appropriate IPC Wizard for your device.

2. Follow the instructions.
   The SIMATIC IPC Wizard recognizes the existing hardware components and automatically installs the associated software. This operation can take several minutes.

   When all software components are installed, the following dialog is displayed:
Note
In the case of server operating systems the dialog contains the “Now” and “Later” buttons instead of “OK”.

3. Complete the installation with the "OK" button; for server operating systems use "Now". The PC is restarted.

Result
You have installed the SIMATIC IPC Wizard software.

1.3.2 Changing, repairing, or uninstalling the IPC Wizard

Requirement
● The IPC Wizard is installed.

Procedure
1. Start the setup again with "Start > All Programs > Siemens Automation > Start_IPC_WIZARD".
2. Select one of the following options:
   – "Modify"
     Change the IPC Wizard: Add or remove software components.
   – "Repair"
     Repair the IPC Wizard: Repair all software components
   – "Remove"
     Uninstall the IPC Wizard: Remove all software components
3. Click the "Next" button.
4. Depending on the selected option, the IPC Wizard responds as follows:
   – "Modify"

   The "Select features" dialog box opens.

   ![Select Features Dialog](image)

   **Note**
   However, only the software components (features) supported by the detected hardware are displayed.

   Select the check boxes for the software components you want to add.
   Clear the check boxes for the software components you want to remove.
   Click the "Next" button.

   – "Repair"

   All installed software components of the IPC Wizard will be repaired. The progress is displayed in the "Setup Status" dialog.

   – "Remove"

   All installed software components of the IPC Wizard will be uninstalled. The progress is displayed in the "Setup Status" dialog.

   **Note**
   Before removing the SIMATIC IPC Wizard, switch back to multi-touch mode (see section "Toggling Switch Touch Mode (Page 33)"). The driver for the keyboard controller are also uninstalled at this time.

5. The message to restart your PC appears. Confirm the message with "OK". For server operating systems, the dialog contains the "Now" and "Later" buttons instead of "OK".
1.3.3 Software components (features)

After installing the SIMATIC IPC Wizard and depending on the hardware, various software components are available on the PC. You can individually activate and deactivate the software components (see "Change the IPC Wizard..."): 

- Screensaver
  - Activate SIMATIC screen saver
  - Change screen saver settings
  - Activate transparent display
  - Adjust brightness value on wakeup

- Brightness
  - Adjust the brightness value for selected or all devices
  - Adjust brightness value on system start

- UPDDSettings
  - Configure clone mode including touch interlock
  - Configure extended mouse functions
  - Calibrate the touch screen and check the calibration
  - Display the status of the operator panel

- PhoneKeypad
  - Alphanumeric keys similar to a cell phone
  - Preview window, which is displayed directly below each input box.

- KeyToolsPhone
  - Set screen saver
  - Change function keys mapping
  - KeyTools
  - Shift key function on and off
  - Activate KeyToolsPhone at system start
Panel Configuration Center (PCC)

2.1 Product description

Along with the SIMATIC IPC Wizard, various software components are installed on your PC depending on the device features, allowing you to configure the connected SIMATIC IPC display. The Panel Configuration Center (PCC) provides a convenient interface for operating these software components.

You can use the PCC to configure your device directly or open the respective setting dialog of the operating system.

2.2 Overview

Requirement

- The IPC Wizard is installed.
- The System requirements (Page 7) are met.

---

Note

Device detection

If you connect another device during operation, for example, a SIMATIC Industrial Flat Panel or if a device is not detected, close the PCC and open it again. The additional devices will then be detected.

---

Note

Windows 7 Fast User Switch

Only one instance of the Panel Configuration Center (PCC) can be open at a given time. This is why Windows 7 "Fast User Switch" for switching multiple simultaneous users is not supported.

1. Close the PCC.
2. Open the PCC as a different user.
Opening and operating the PCC

1. Click on the "Panel Configuration Center" icon on the Desktop.
   Select "Start > All Programs > Siemens Automation > Panel Configuration Center > Panel Configuration Center".

2. Change a setting directly on the interface. All settings are immediately applied and permanently stored.

Depending on the device, device features are shown on the left in several tabs. These tabs summarize one or more software components on the device (see section "Availability"):

- "Brightness" tab: Individual adjustment of the brightness of all connected devices, see section "SetBrightness (Page 17)".
- "Interlock" tab: The interlock prevents the simultaneous operation of multiple devices during clone mode, see section "Interlock in clone mode (Page 31)".
- "Screen saver" tab: Activates and configures the "IPCScreenSaver" screen saver, see section "IPCScreenSaver (Page 19)".
• "Touch settings" tab for devices with capacitive multi-touch screen:
  – "Tablet PC settings": Opens the Windows "Tablet PC settings". You use a virtual "OnScreenKeyboard" (OSK) from the operating system when using the tablet PC functionality, for example, Windows 7 and WES7P.

  Note
  Extended monitor mode with two or more screens
  To extend the Desktop with all connected touch devices, you must assign the touch devices to the displays once under Windows:
  1. Connect an external keyboard to the PC.
  2. In the "Interlock" tab, disable the "Activate interlocks" option.
  3. Click on the "Tablet PC settings" button.
  4. Change to the "Display" tab.
  5. Click the "Setup" button.
  6. Touch the touch screen one after the other (display 1, 2, etc.).
  7. To complete the assignment, press any key on the external keyboard.

  – "Switch touch mode": Toggles between multi-touch mode and single-touch mode, see section "SIMATIC Switch Touch Mode (Page 32)".
  – Screen display: Toggles all connected devices between portrait and landscape orientation.

• "UPDD Settings" tab: Universal Pointing Device Driver (UPDD): Touch settings for devices with resistive single-touch screen:
  – "Check calibration": Opens a test screen with buttons without function. Touch the screen and try to activate the individual buttons. This helps to recognize the quality of the screen calibration.
  – "Calibration": Immediately starts the 3-point calibration of the UPDD, see section "Standard calibration (Page 25)".
  – "Settings": Opens the UPDD configuration menu (Page 22) with a variety of device settings, for example, Extended calibration (Page 26), Touch functionality (Page 27) or the interlock mechanism in clone mode.

Closing the PCC

Close the PCC in the menu bar via "Menu > Exit".
## Availability

The following table shows the software components available for specific devices:

<table>
<thead>
<tr>
<th>IPC Wizard software component</th>
<th>Devices</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>with capacitive multi-touch screen</td>
</tr>
<tr>
<td>UPDD</td>
<td>-</td>
</tr>
<tr>
<td>Panel PC Tools</td>
<td></td>
</tr>
<tr>
<td></td>
<td>SetBrightness</td>
</tr>
<tr>
<td></td>
<td>IPCScreenSaver</td>
</tr>
<tr>
<td>PhoneKeyPad</td>
<td>-</td>
</tr>
<tr>
<td>Switch touch mode</td>
<td>x</td>
</tr>
<tr>
<td>KeyTools</td>
<td>-</td>
</tr>
</tbody>
</table>
Software description

3.1 General for all devices

3.1.1 Panel PC Tools

3.1.1.1 SetBrightness

Overview
Adjusts the screen brightness for all connected and detected SIMATIC devices. Excluded are devices that do not support the DDC interface or the brightness functions of the DDC interface, for example, most older monitors connected via VGA.

Setting the display brightness

Procedure
The following figure shows the "Brightness" tab in the PCC and an example with two devices, 1 and 2.

---

**Note**

**Full device detection**
Devices that are connected or removed during ongoing operation, appear or disappear in the "Brightness" tab after restarting the PCC. You can adjust the brightness only when the devices have been fully detected.

**Deviating numbering**
Depending on the graphics chip and operating system, the numbering of the devices may deviate from the numbering in Windows:
Double-click on the device icon The associated device flashes several times in quick succession.

---
Software description

3.1 General for all devices

1. Open the PCC and go to the "Brightness" tab.

2. Select the device whose brightness display you want to change. In the example, device "1" is selected, all other devices are not selected. If no device is selected, the display brightness of all devices is changed to the same degree.

3. Set the desired display brightness. You have the following setting options:
   - Using the slider. The set value is applied when you release the slider.
   - Using the "Increase brightness (+)" and "Decrease brightness (-)" buttons.

   **Note**
   The minimum value for the brightness setting is 10%. If you select a value of less than 10% using one of the setting options, the brightness value is automatically set to 10%.

4. To set a fixed brightness value for all devices at every system startup - except for hibernation, standby - select "Brightness value at system startup".
   Enter the desired brightness in percent in the box on right. The setting is valid only for the current user and first takes effect upon logon.
   If you disable "Brightness value at system startup", the brightness value set in step 3 takes effect.

5. If needed, enable "Use brightness value for all connected devices." Alternatively, click in the empty box next to the device icon. Then the brightness is the same again for all devices.

**Principle**

If the PCC is started and appears as an icon in the taskbar, you can change the icon brightness using the small buttons in the preview window.
Command line call

Call parameters

The "SetBrightness" program can be called in the command line with the following options:
SetBrightness.exe

Note

In contrast to the graphical interface, the minimum value is set to 0 % in command line mode. In this case, the backlighting is switched off. By pressing an input device, for example, a touch screen or keyboard, the display is switched on again with 100% brightness value. The first input event, for example, a mouse click, is discarded in this case to avoid an unintentional incorrect operation.

[VALUE] parameter

The parameter must be specified for each command line call of the "SetBrightness" program. The following options are available for selection:

<table>
<thead>
<tr>
<th>Value</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>The brightness value specified by VALUE (0 … 100) is applied.</td>
</tr>
</tbody>
</table>

Example: Calling c:\setbrightness.exe 50 corresponds to a brightness of 50 %.

3.1.1.2 IPCScreenSaver

Introduction

The SIMATIC "IPCScreenSaver" is a standalone software component that is installed via the IPC Wizard. You can configure the screen saver on the PCC from which you open the Windows standard dialog "Screen Saver Settings".

The "IPCScreenSaver" switches on after a configured time, e.g. 1 min. Then the brightness of all connected devices is set to the configured value, e.g. 23%. In contrast to most conventional screen savers, the "IPCScreenSaver" can save energy: The power consumption of screens set to dark is less than screens with high or normal brightness.

NOTICE

Device no longer operable

When you select Activate 'IPCScreenSaver' screen saver and Windows screen saver are activated at the same time, the device may become inoperable. This may damage the machine or plant.

Disable the Windows screen saver: Under "Start > Control Panel > Power Options > Choose when to turn off a display", set the "Turn off display" option to "Never".

Note

If an additional device is connected to the PC during operation, the PC must be rebooted. During the Windows startup, the additional device is detected and connected.
Software description

3.1 General for all devices

Procedure

1. Open the PCC and go to the "Screen saver" tab.

2. Select "Activate 'IPCScreenSaver' screen saver".

3. Open the "Screen Saver Settings".

4. Under "Screen saver", select the "Ipccscreensaver" screen saver.
5. Click on the "Settings" button. The "Ipcscreensaver" dialog box opens.

6. Set the waiting time until a screen saver switches on.

7. Make additional settings as needed. Close all open dialogs.

---

**Note**

**No screen saver**

If you select "Ipcscreensaver" as the screen saver and disable it in step 2, no other screen saver is activated. The device has no screen saver until you either activate the "Ipcscreensaver" again or select another screensaver from the Windows screen saver settings.

8. Set the desired "Brightness" for the connected devices using the slider or the "+" and "+" buttons.

   If you set the value "0%" as the "Brightness", the backlighting of the display is disabled.

9. If needed, select "Screen saver transparent, desktop visible". The screen saver generates by default a black full screen window on each screen. With the "Screen saver transparent, desktop visible" option, the window is transparent and the static screen of the desktop is visible.

10. If needed, select "Wake up with 100% brightness". After switching off the screen saver, the screens of all connected devices are operated with 100% brightness.
3.2 Special for devices with resistive single touch screen

3.2.1 Universal Pointing Device Driver (UPDD)

3.2.1.1 Overview UPDD Console

The Universal Pointing Device Driver (UPDD) offers the following functions for single-touch operator panels:

- Configure clone mode with several operator panels, including touch interlock
- Configure extended mouse functions
- Configure properties for operating the touch screen
- Calibrate the touch screen and check the calibration
- Display the status of the operator panel

This chapter describes the following typical applications:

- Calibrate touch screen (Page 24)
- Deactivate touch functionality (Page 27)
- Activated extended touch functions (Page 28)
- Touch in Extended Monitor Mode (Page 28)

For the meaning of all UPDD parameters, refer to the Online Help.

UPDD Console

The UPDD Console is used to configure the UPDD driver:

1. Open the PCC and go to the "UPDD Settings" tab.
2. Click on the "Settings" button. The UPDD Console dialog box opens.
3.2 Special for devices with resistive single touch screen

The "Hardware" tab shows the touch controllers of devices detected by the UPDD driver.

If you remove one of the devices recognized by the UPDD driver, the associated touch controller is marked red.

In the following example the connection to the device with the "Elo.Smartset(4)" touch controller was removed.

If you reconnect the device with the "Elo.Smartset(4)" touch controller, the "Elo.Smartset(4)" entry is highlighted in black again.
3.2 Special for devices with resistive single touch screen

If you no longer need the device with the "Elo.Smartset(4)" touch controller, you can select the touch driver and remove it by using the "Remove this device" button.

---

**Note**

**Removing disconnected devices from the list**

To ensure proper functioning of the UPDD driver, remove the touch controllers of all devices that are not connected from the touch controller list.

---

### 3.2.1.2 Notes on clone mode

In clone mode, all screens of the connected devices show the same content.

The touch screen is secured by means of an interlocking mechanism. When a device is being operated, the operation of any other devices is blocked for a certain time. This means it is not possible to execute an operator action simultaneously on multiple operator panels.

**Procedure**

1. Open the "UPDD Console" dialog.
2. Select "Properties > Interlock".
3. Enter the value > 0 for the "Timeout".

**Disabling the interlock**

To disable the interlock, set the the value "0" for the "Timeout".

### 3.2.1.3 Calibrate touch screen

**Calibrating the touch screen**

The touch screen of the device is pre-calibrated (3-point calibration) in the delivery state. The following two calibration types are available to recalibrate the touch screen:

- **Standard 3-point calibration:**
  
  The calibration data are stored in the EEPROM on the device.

- **Advanced calibration with up to 25 calibration points, recommended if there are special requirements for accuracy:**
  
  The calibration data are stored in the registry of the operating system on the PC.
Standard calibration

Procedure

1. Open the "UPDD Console" dialog.
2. Select the touch controller of the device you want to calibrate in the header of the dialog.
3. Click the "Calibration" tab.
4. Activate the option "Use eeprom storage". For Touch Controllers with EEPROM, the option box is pre-selected.
   The option box "Number of points" shows "3-point calibration".
5. Click the button "Calibrate".
   The calibration screen is displayed in the selected display.
6. Quickly touch the corresponding selections one after the other.
   The entry is confirmed by a check mark, the next selection is displayed.
7. Confirm all input prompts (arrows, or crosses in the center) until the complete screen has been calibrated.

Note

If the screen does not respond to touch as expected, check the controller selected under "1." in "UPDD Console" and repeat the calibration. Only an active touch controller can be calibrated. A removed touch controller is displayed in red.

If the accuracy of this 3-point calibration is not sufficient, you can clear the "Use eeprom storage" option box and use the extended 25-point calibration instead.
Extended calibration

Procedure

1. Open the "UPDD Console" dialog.
2. Select the touch controller of the device you want to calibrate in the header of the dialog.

![UPDD Console dialog]

3. Click the "Calibration" tab.
4. Deactivate the option "Use eeprom storage".
5. Enter the value "25" under "Number of points".
6. Click the button "Calibrate". The calibration screen is displayed in the selected display.
7. Touch the corresponding selections one after the other. The entry is confirmed by a check mark, the next selection is displayed.
8. Confirm all input prompts (arrows, or crosses in the center) until the complete screen has been calibrated.
9. Finally, press "Confirm" for the input prompt.
3.2.1.4 Touch functionality

Deactivate touch functionality

Procedure

1. Open the "UPDD Console" dialog.
2. In the header of the dialog, select the touch controller you want to deactivate.
3. Select the "Properties" tab.
4. Deactivate the "Enabled" option.
   The controller is deactivated.

Note
If you close the dialog box using "Close", the touch functionality remains deactivated.
If you have not connected a mouse, you can also reactivate the touch panel by means of a keyboard entry. Restart the "UPDD Console" via the start menu.
The keyboard entry <Alt+p> opens the "Properties" tab. Then the touch panel can be reactivated by entering <Alt+n>. (Option button "Enabled")
Extended Touch touch functionality

Procedure

1. Open the "UPDD Console" dialog.
2. Select the touch controller of the device you want to activate the extended touch functions for in the header of the dialog.
3. Select the "Click Mode" option.
4. Activate the option "Extended Touch".

**Note**

"Extended touch" is only available for the Windows 7 Ultimate and WES7P operating systems.

If "Extended touch" is activated, the extended touch functions of Windows 7 are also available, such as permanently touching the touch screen, which corresponds to the right mouse button function. In addition, a virtual "OnScreenKeyboard (OSK)" is automatically opened for the Windows logon and when input boxes are activated.

Touch in Extended Monitor mode

In Extended Monitor mode you can operate a PC with several touch devices.

Requirement

- All touch devices are connected to the PC.
Procedure

In the following description for setting up Extended Monitor mode, one touch device is set up in portrait format and one touch device in landscape format. The description can also be applied for two touch devices in landscape format.

1. Open the Windows display settings using one of the following methods:
   - Select "Start > Control Panel > Display > Change display settings"
   - Right-click on the desktop. Select "Screen resolution" from the shortcut menu.
   - Select "Start > Run", enter "desk.cpl" and confirm the input with <RETURN>.

2. Set the resolution and orientation of the connected touch devices:
   - Select a screen resolution under "Resolution".
   - In the "Orientation" input box, select the entry "Landscape" or "Portrait (flipped)".

3. Close the dialog with the "OK" button.
4. Open the "UPDD Console" dialog.

5. Click the "Hardware" tab.

6. Click "Handling Whole desktop".

   The "Desktop Area" dialog box opens.

7. Click "Configure All...".

   You are prompted to touch the touch screens of the connected touch devices one after the other.

   When you are finished, the UPDD driver includes the assignment of the monitors to the corresponding touch screens.

8. Calibrate the touch screens of the touch devices one after the other. All touch devices must be calibrated with an extended calibration of at least 9 points. A description of the calibration procedure is available in chapter "Extended calibration" (Page 26).
3.3 Special for devices with capacitive multi-touch screen

3.3.1 Interlock in clone mode

3.3.1.1 Notes on clone mode

In clone mode, all screens of the connected devices show the same content.

The touch screen is secured by means of an interlocking mechanism. When a device is being operated, the operation of any other devices is blocked for a certain time. This means it is not possible to execute an operator action simultaneously on multiple operator panels.

3.3.1.2 Activating the interlock mechanism

Introduction

The interlock mechanism in clone mode prevents simultaneous operation of two devices.

If you have two or more touch screens, which are operated spatially separate from one another, two operators can use the same application simultaneously. You use the interlock to prevent reversing an input on device 1 by a second input on device 2: When a device is being operated, the operation of any other devices is blocked for a certain time.

The time until the device is released is reset with each new touch input. There is no visual feedback for which panels are locked and which panel is being operated. The touch devices are controlled in the background by the "HidLock.exe" application, so that the PCC does not have to be open for the function to be available.

If you remove a connected device from the PC while it is locked, it releases as soon as you connect it to the PC again. The interlock of a device is a setting in the non-permanent, volatile memory and therefore is only effective during operation.

Procedure

1. Open the PCC and go to the "Interlock" tab.
2. Activate "Activate interlock".
3. Specify the "Interlock time", for example, timeout 10 seconds.

As soon as operation is performed on a device, operation of the other device is blocked for 10 seconds. An input or touch of the screen then has no effect for 10 seconds.
3.3 Special for devices with capacitive multi-touch screen

3.3.2 SIMATIC Switch Touch Mode

3.3.2.1 Overview

You operate a device a with a capacitive multi-touch screen using up to five fingers. In doing so, the device recognizes gestures such as swiping, zooming, and rotating. The WES7E operating system is not supported.

The SIMATIC Switch Touch Mode tool changes the touch controller of a connected multi-touch device (five fingers, gestures) over to single-touch mode. In single-touch mode, the device behaves like a single-touch device that you operate with a single finger only and without gestures.

After the changeover, you can operate your multi-touch device with the WES7E operating system.

Differences and limitations in single-touch mode

- **Opening the shortcut menu**: In order to open the shortcut menu in single-touch mode, follow these steps:
  
  Tap and hold a position 1 and briefly tap on any position 2 while doing so.

- **Virtual keyboard**: A virtual keyboard is displayed for logon.

- **Changeover**: Multi-touch / single-touch mode in "Landscape" orientation.

- **Only one device can be operated in extended monitor mode**. The other devices are not recognized by the touch controller. Therefore, operate multiple devices in clone mode.
3.3.2.2 Toggling Switch Touch Mode

Device detection

All detected devices are displayed in a list in the PCC with the "Touch settings" tab. In addition to the device name, the touch mode of a device is shown: Multi-touch mode or single-touch mode.

Procedure

1. To determine which entry in the list belongs to a given device, operate the connected devices one by any with a touch input. The corresponding entry for the action is highlighted in blue in the list for a short time.

2. To change the touch mode for a device, click on the respective "Switch Mode" button. The touch mode of the device displayed next to the button changes.

Toggling in single-touch mode

The device is in **single-touch mode**. **Check:** If you draw a rectangle on the touch screen with your finger, you will see an arrow – the typical mouse pointer – under your finger.

Toggling in multi-touch mode

In order to change back to multi-touch mode, follow these steps:

1. Click on the "Switch Mode" button.

The device is in **multi-touch mode**. **Check:** If you draw a rectangle on the touch screen with your finger, you will see a small dot under your finger.
3.4 Special touch/key devices

3.4.1 KeyToolsPhone

3.4.1.1 Overview

SIMATIC IPC KeyTools_Phone offers the following functions for key devices:

- Configure keyboard layout properties for operating the keys
- Configure clone mode with multiple operator panels, including key interlock
- Configure extended functions in clone mode, for example:
  - Set a minimum time between two key operations
  - Display the status of the operator panel
- KeyTools status display
  Summary of KeyTools information
- Configure keycode table
  Load and edit keycode tables
- Configure security features
  Activate and deactivate safety-related settings
- Control LEDs
  Control of LEDs using the "LedControl" tool for front panels that have function keys with LEDs

Note

Front panel keyboard

The term "front panel keyboard" used in the following applies only for keyboards on the operator panels.

Selecting the language

To display all pre-programmed characters correctly, the input language and language properties in Windows must be set to "United States-International". See section Language selection for key devices [Page 54].
3.4 Special touch/key devices

3.4.1.2 Clone mode

Notes on clone mode

In clone mode, all screens of the connected devices show the same content.

The touch screen is secured by means of an interlocking mechanism. When a device is being operated, the operation of any other devices is blocked for a certain time. This means it is not possible to execute an operator action simultaneously on multiple operator panels.

Note

Maximum of two key devices in clone mode

A maximum of two key devices can be operated simultaneously in clone mode.

Malfunction due to incorrect mapping of the keyboard

If you connect two key devices with different key layouts to an industrial PC, incorrect mapping of the key layout table can result in malfunctions. This may damage the machine or plant.

Connect only keys devices with the same key layout.

Disabling the interlock

To disable the interlock, set the value "0" for the "Timeout".

Note on 15" touch/key device

Requirements

- A SIMATIC Industrial Flat panel is connected to at least one PC.
- Close mode is enabled.
- A 15" touch/key device is connected

NOTICE

Security gaps in clone mode

Under the requirement described above, a password entry on the second screen is displayed in plain text with letters and not hidden by asterisk *. Confidential entries such as passwords can be read and misused. The security of the machine or plant is threatened.

Protect confidential data from unauthorized access:

- Disable the preview window, for example, for the PhoneKeyPad (see "Special for touch/key devices").
- Use a USB keyboard.
- Switch off the second screen.
- Reduce the brightness of the second screen.
### Interlock mechanism in clone mode

#### Function of the interlock mechanism

The interlock mechanism in clone mode prevents simultaneous operation of two devices. A timeout defines how long the unoperated device is locked.

The timeout is set in a registry key, see section Setting the timeout (Page 36).

<table>
<thead>
<tr>
<th>Type of interlocking</th>
<th>Brief description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Timer mode</td>
<td>“Timer mode” is always active. The timeout in timer mode is assigned to an device as soon as operator input occurs. As long as the timeout has not expired, no input is permitted on another device.</td>
</tr>
</tbody>
</table>

#### Configuring the timeout

The duration of the interlock (timeout) defines how long the non-operated device is locked. The timeout is stored in a registry key in the Windows registry.

This data is read in at system startup and used as start values for the driver.

The respective procedure is described in the following sections.

#### Setting the timeout

**Defining the runtime for timeout after keystroke**

This variable defines the value of the runtime in milliseconds.

The variable is a DWORD. The interface to the driver can only process positive values. The runtime is entered into the registry as a hexadecimal value.

During the driver installation at system startup, this variable is automatically created in the registry by the INF files (default is 3000 ms = 0bb8 hexadecimal).

**Path**

[HKEY\LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\filter]

"TimeOut"=dword:00000bb8

**Visualization interfaces to other applications**

On the application level, data can be read or sent from the driver. An application that implements the corresponding driver interfaces is required for this purpose. Access by the application is possible via three user interfaces in the USB keyboard controller driver (package version 2.4 or higher). These interfaces with examples for access in C++ are described in the following sections.

The interfaces are IOCTL commands. The calls are executed as functions in the driver to change the status of the driver.
Updating the timeout value

If this command is called, the timeout value is read for the driver from the registry during runtime. The updated value is then returned.

Calling the command in C++

You access the command as follows in C++:

```c
#define IOCTL_ADMIN_TIMEOUT_READ_REG CTL_CODE(FILE_DEVICE_UNKNOWN, 0x805, METHOD_BUFFERED, FILE_ANY_ACCESS)    //GTA update the TimeOut value from the registry
HANDLE hdevice = CreateFile("\\?\KeyHookFilter", GENERIC_READ | GENERIC_WRITE, 0, NULL, OPEN_EXISTING, 0, NULL);

if (hdevice == INVALID_HANDLE_VALUE)
{
    AfxMessageBox("INVALID_HANDLE_VALUE - KeyHookFilter - Not found! ");
} else
{
    DWORD junk;
    volatile DWORD Admin_MODE_Status; //volatile DWORD
    KeyHookFilterStatus;
    TimeOut = 0;

    if( DeviceIoControl(hdevice, IOCTL_ADMIN_MODE_STATUS, NULL, 0, (PVOID)& TimeOut, sizeof(Admin_MODE_Status), &junk, NULL))
    {
        AfxMessageBox("TimeOut update is: %d", TimeOut);
    }
    CloseHandle(hdevice);
}
```
3.4.1.3 Operating the KeyToolsPhone

**Procedure**

1. Open the SIMATIC IPC KeyTools with "Start > All Programs > Siemens Automation > Panel Configuration Center > KeyToolsPhone > IPC KeyToolsPhone".

2. Use the "Restore Key_Phone default settings" button to restore the key assignment to the factory state.

3. Use the "OK" button to exit the program and apply the changes made to the KeyTools setting.

4. Use the "Cancel" button to exit KeyTools. The changes are not applied.

5. Use the "Apply" button to apply changes made to the KeyTools setting.
"Status" area

When the program is called for the first time, no value is displayed for "Key table" in the "Status" area. Values are only displayed after a keyboard table is loaded.

<table>
<thead>
<tr>
<th>Status</th>
<th>Information display</th>
</tr>
</thead>
<tbody>
<tr>
<td>TACO Version</td>
<td>Release version of USB keyboard controller</td>
</tr>
<tr>
<td>Key table</td>
<td>Last file loaded for the USB keyboard controller</td>
</tr>
<tr>
<td>Security enabled</td>
<td>Activation status of security settings</td>
</tr>
<tr>
<td>WinCC hotkey enabled</td>
<td>Activation status of &quot;WinCC hotkey&quot; function</td>
</tr>
</tbody>
</table>

"Keycode table" area

Select one of the options in the "Keycode table" area.

"IPC PhoneKey Panel_15"wide – (F1 – F36)" option

When you select "IPC PhoneKey Panel_15"wide – (F1 – F36", a pre-defined default keycode table is loaded. This key assignment corresponds to the factory state.

<table>
<thead>
<tr>
<th>Keys</th>
<th>Keycode</th>
</tr>
</thead>
<tbody>
<tr>
<td>F1 to F12</td>
<td>F1 to F12</td>
</tr>
<tr>
<td>F13 to F24</td>
<td>Shift + F1 to Shift + F12</td>
</tr>
<tr>
<td>F25 to F36</td>
<td>Ctrl + F1 to Ctrl + F8</td>
</tr>
<tr>
<td>Alphanumeric, cursor and control keys</td>
<td>USA international</td>
</tr>
</tbody>
</table>
The default settings of the function keys <F13 to F20> correspond to the specifications required for using the keys, for example in the SIMATIC HMI software.

Note
The security features are activated – see section:
- "Status" area (Page 39)
- "Security features" area (Page 45)

Procedure
To send the keycode table to the keys of the key device, follow these steps:
1. Activate "Send table".
2. Select the option "IPC PhoneKey Panel_15"wide – (F1 – F36)".
3. Click on "Apply" or "OK" to confirm.

The keycode table is sent. The sent keycodes are activated immediately.

The keycode table cannot be changed.

"IPC PhoneKey Panel_15"wide – (F1 – F12)" option
When you select "IPC PhoneKey Panel_15"wide – (F1 – F12)", a PC-compatible keycode table is loaded. The following applies:
- The function keys F1 to F12 correspond to the mapping of a PC keyboard
- Function keys F13 to F36 are not used.

Option "User specific"
Select the "User specific" option to:
- Load a custom keycode table and assign the keys of a key device
- Edit the key mapping
Load a custom keycode table and assign the keys

1. Activate "Send table > User specific".

2. Press the "Browse" button or select the menu command "File > Key table"
3.4 Special touch/key devices

The "Open" dialog box is displayed.

The "C:\Program Files\Siemens\Automation\PanelConfigurationCenter\PhoneKeyPad" directory contains the following files for a 15" widescreen key device:

- The file "tab15w.pad" with the keycodes "Default Panel PC"
- The file "tab15w_st.pad" with the keycodes "Standard PC compatible"

3. Select the desired file and click "Open".

4. Select "Apply" to assign the selected keycode table to the keys of the key device or "Cancel" to abort.
Editing the key mapping

If you load a custom keycode table and assigned to the keys of the key device, you can edit the key mapping of the F keys using the KeyPad.

1. Activate "Send table > User specific".

2. Select "File > Open KeyPad".

   The KeyPad opens.
3. Open the assignment of an F key with a mouse click use the "Enter" key.

The "Key definition" dialog box opens.

- In "Normal mode", define which keycode is to be sent.
- The options allow you to specify which keycode is assigned in addition to the keycode under "Name".

Example:

<table>
<thead>
<tr>
<th>Name</th>
<th>Option</th>
<th>Display/function</th>
</tr>
</thead>
<tbody>
<tr>
<td>F1</td>
<td>-</td>
<td>F1</td>
</tr>
<tr>
<td>F1</td>
<td>LCtrl</td>
<td>F1 + Ctrl</td>
</tr>
</tbody>
</table>

The section "Keycode table (Page 54)" contains a list of all names which can be selected in the "Name" group. The "Display/function" column lists the display or function which is triggered when the respective button is clicked.
4. Pressing the "Send!" button assigns the complete, edited keycode table to the keys. The changes take effect immediately.

**Note**
The "Send!" button is only enabled if the application has been started on a key device. The keyboard layout is English (USA international). Please note that the layout of an external keyboard must correspond to the international character set. This layout guarantees that the characters on the keys agree with the characters on the screen.

You can use the "IPC Keyview" program to view the keycodes of pressed keys.
Open the "IPC Keyview" with "C:\Program Files\Siemens\Automation\PanelConfigurationCenter\KeyTools\Keyview\KeyView.exe" or via the Start menu.
As soon as you press a key, the corresponding codes appear in the "IPC Keyview" window.

<table>
<thead>
<tr>
<th>Message</th>
<th>Key</th>
<th>Char</th>
<th>Repeat</th>
<th>Scan</th>
<th>Ext</th>
<th>All</th>
<th>Prev</th>
<th>Tran</th>
</tr>
</thead>
<tbody>
<tr>
<td>MW_CHAR</td>
<td>0x0051 a</td>
<td>1</td>
<td>30</td>
<td>No</td>
<td>No</td>
<td>Up</td>
<td>Down</td>
<td></td>
</tr>
<tr>
<td>MW_KEYUP</td>
<td>65 A</td>
<td>1</td>
<td>30</td>
<td>No</td>
<td>No</td>
<td>Down</td>
<td>Up</td>
<td></td>
</tr>
<tr>
<td>MW_KEYDOWN</td>
<td>66 B</td>
<td>1</td>
<td>48</td>
<td>No</td>
<td>No</td>
<td>Up</td>
<td>Down</td>
<td></td>
</tr>
<tr>
<td>MW_CHAR</td>
<td>0x0052 b</td>
<td>1</td>
<td>48</td>
<td>No</td>
<td>No</td>
<td>Up</td>
<td>Down</td>
<td></td>
</tr>
<tr>
<td>MW_KEYUP</td>
<td>66 B</td>
<td>1</td>
<td>48</td>
<td>No</td>
<td>No</td>
<td>Down</td>
<td>Up</td>
<td></td>
</tr>
<tr>
<td>MW_KEYDOWN</td>
<td>67 C</td>
<td>1</td>
<td>46</td>
<td>No</td>
<td>No</td>
<td>Up</td>
<td>Down</td>
<td></td>
</tr>
<tr>
<td>MW_CHAR</td>
<td>0x0053 c</td>
<td>1</td>
<td>46</td>
<td>No</td>
<td>No</td>
<td>Up</td>
<td>Down</td>
<td></td>
</tr>
<tr>
<td>MW_KEYUP</td>
<td>67 C</td>
<td>1</td>
<td>46</td>
<td>No</td>
<td>No</td>
<td>Down</td>
<td>Up</td>
<td></td>
</tr>
<tr>
<td>MW_KEYDOWN</td>
<td>68 D</td>
<td>1</td>
<td>32</td>
<td>No</td>
<td>No</td>
<td>Up</td>
<td>Down</td>
<td></td>
</tr>
<tr>
<td>MW_CHAR</td>
<td>0x0054 d</td>
<td>1</td>
<td>32</td>
<td>No</td>
<td>No</td>
<td>Down</td>
<td>Up</td>
<td></td>
</tr>
<tr>
<td>MW_SYSKEYDOWN</td>
<td>18 ALT</td>
<td>1</td>
<td>56</td>
<td>No</td>
<td>Yes</td>
<td>Up</td>
<td>Down</td>
<td></td>
</tr>
</tbody>
</table>

"Security features" area

**Function "Security enabled"**
With the "Security enabled" option, the F keys of a key device are interlocked. The "Security features" are always activated in the factory state of a SIMATIC IPC.

**WARNING**
Personal injury or property damage can result from malfunctions due to lacking key interlock
For security reasons it is recommendable to always use the "Security features" and not to deactivate them.
If "Security features" is nevertheless deactivated by the user, it must be guaranteed that no malfunctions can be triggered in the application program.
Clone mode is only permitted if the "Security features" are activated.
The interlocking mechanism is inactive during deactivation.
3.4 Special touch/key devices

- If you activate "Security enabled", the "Security features" are effective immediately. You do not need to restart the device.
- If you deactivate "Security enabled", the "Security features" become ineffective immediately.

**WARNING**

Personal injury or property damage can result from malfunctions due to lacking key interlock

If you deactivate "Security features", significant malfunctions may occur in the user software when using function keys <F13 to F36> or when using custom keycode tables. The keycodes associated with the function keys can also be triggered by keys other than the configured ones.

The following is generally applicable:
Malfunctions can also be triggered by external input devices or combinations of external input devices and key devices. The "Security features" are ineffective in such cases.

- When using function keys within WinCC (TIA Portal), a reaction in the automation process is directly assigned to individual keys by the configuration settings.
- To guarantee safe operation of the automation process, make sure that only the configured key triggers the desired reaction.
- If the same keycode can be sent using other function keys, so-called "ghost keys" then exist. This must be prevented.
- Triggering of "ghost keys" from the front panel keyboard is prevented by the activated "Security features".
Principle of operation of the "Security features"

If one of the "Default Panel PC" keycode tables is loaded, the following strings are sent by the keyboard controller of the front panel keyboard when an <F> key is pressed:

<table>
<thead>
<tr>
<th>Key pressed</th>
<th>Keycode string sent</th>
</tr>
</thead>
<tbody>
<tr>
<td>F1 to F12</td>
<td>F (1 to 12)</td>
</tr>
<tr>
<td>F13 to F24</td>
<td>Shift + F(1 to 12)</td>
</tr>
<tr>
<td>F25 to F36</td>
<td>Ctrl + F(1 to 12)</td>
</tr>
</tbody>
</table>

The <F1 to F12> keys of the front panel keyboard send the same keycodes as an external USB or PS/2 keyboard. An extension of the keycode string has been defined for the remaining 24 <F> keys because only a limited number of keycodes is made available by the operating system. These <F> keys are defined by the keycode string <Shift> or <Ctrl+F(1 to 12)>.

If the <Shift> and <Ctrl> keys as well as the <F> keys are pressed simultaneously, "ghost keys" may be triggered in the customer application as a result of the combination of keycode strings. Examples are listed in the following table.

<table>
<thead>
<tr>
<th>Key 1</th>
<th>Key 2</th>
<th>Desired key</th>
<th>Activated key</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shift (Shift)</td>
<td>F1 (F1)</td>
<td>Shift and F1</td>
<td>F13</td>
</tr>
<tr>
<td>Ctrl (Ctrl)</td>
<td>F1 (F1)</td>
<td>Ctrl and F1</td>
<td>F25</td>
</tr>
<tr>
<td>F14 (Shift, F2)</td>
<td>F1 (F1)</td>
<td>F14 and F1</td>
<td>F14</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>(Shift, F2)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>(Shift, F1)</td>
</tr>
</tbody>
</table>

Key 1 and key 2 are pressed simultaneously. The desired key and the actually activated key are displayed ("Security features" are deactivated). The sent keycode string is shown in parentheses.

Simultaneous pressing of two <F> keys, as well as combination of the <Shift> or <Ctrl> key with an <F> key is therefore blocked by the "Security features" in the factory state.

The following checks must be made in this case:

- Can an undesired function be triggered by simultaneously pressing the <Shift> key and an <F> key?
- Can an undesired function be triggered by simultaneously pressing the <Ctrl> key and an <F> key?
- Can an undesired function be triggered by simultaneously pressing two <F> keys?

Functions triggered by mistake can be avoided by:

- Changing the keycode table by editing using "Keycode table > User specific > Edit"
- Changing the user application
Example

Two functions are defined in the customer application, where the following prerequisites apply:

- "Security features" are deactivated and the "IPC PhoneKey Panel_15"wide – (F1 – F36)" keycode table is loaded.
- The desired function "X" is triggered by simultaneously pressing the <Shift> and <F1> keys.
- The function "Y" is triggered by pressing the <F13> key.

Note

The following keycode sequences exist for <Shift + F1> and <F13>. The customer application cannot distinguish which keys have been pressed. The result is an undefined reaction of the customer application:

- The function "Y" can be triggered by pressing the two keys <Shift+ F1>.
- The function "X" can be triggered when pressing the <F13> key.

Solution

Approach 1:

The keycode table is modified using "User specific > Edit" such that a different keycode string is sent when pressing the function key <F13>, e.g. <ALT + F1>. The customer application must be able to appropriately evaluate this new keycode string.

Approach 2:

The customer application is modified such that the function "Y" is not assigned to function key <F13> but e.g. to <F12>. The function keys <F1> and <F12> have different keycodes in the keycode table "IPC PhoneKey Panel_15"wide – (F1 – F36)".

Function "WinCC hotkey"

<table>
<thead>
<tr>
<th>Security features</th>
</tr>
</thead>
<tbody>
<tr>
<td>Security enabled</td>
</tr>
<tr>
<td>WinCC hotkey enabled</td>
</tr>
</tbody>
</table>

Certain programs, for example, WinCC (TIA Portal), interpret the sequence of keycodes sent over the keyboard interface in their own manner. The function "WinCC hotkey" permits adaptation to this response.
Example

If you activate "WinCC hotkey enabled", the keycode for "Releasing a function key" is sent in the exchanged keycode string expected from WinCC (TIA Portal).

The following tables list the keycode strings sent with the "WinCC hotkey" function activated or deactivated:

- Keycode string with function "WinCC hotkey" deactivated:

<table>
<thead>
<tr>
<th>Function keys</th>
<th>Press key</th>
<th>Release key</th>
</tr>
</thead>
<tbody>
<tr>
<td>F1 to F12:</td>
<td>F (1 to 12)</td>
<td>F (1 to 12)</td>
</tr>
<tr>
<td>F13 to F24:</td>
<td>Shift, F(1 to 12)</td>
<td>Shift, F(1 to 12)</td>
</tr>
<tr>
<td>F25 to F36</td>
<td>Ctrl, F(1 to 12)</td>
<td>Ctrl, F(1 to 12)</td>
</tr>
</tbody>
</table>

- Keycode string with function "WinCC hotkey" activated:

<table>
<thead>
<tr>
<th>Function keys</th>
<th>Press key</th>
<th>Release key</th>
</tr>
</thead>
<tbody>
<tr>
<td>F1 to F12:</td>
<td>F (1 to 12)</td>
<td>F (1 to 12)</td>
</tr>
<tr>
<td>F13 to F24:</td>
<td>Shift, F(1 to 12)</td>
<td>F(1 to 12), Shift</td>
</tr>
<tr>
<td>F25 to F36</td>
<td>Ctrl, F(1 to 12)</td>
<td>F(1 to 12), Ctrl</td>
</tr>
</tbody>
</table>

If "WinCC hotkey enabled" is activated, the "WinCC hotkey" function is automatically started when booting the Panel PC.

Controlling LEDs of the key devices

The LEDs are controlled using the command shell application "LEDControl" with the following functions.

- Switch off LED
- Switch on LED
- Flash LED
- Query current status of LED

See also Parameter (Page 51)
Command shell application "LEDControl"

Procedure for actuating the LEDs

1. Open the command shell application with "Start > Run > cmd".
2. Confirm with "OK."
3. The shell command prompt is displayed.
4. Enter the command "LEDControl" and confirm the entry.

The command shell dialog box is opened.

**Access**: LEDControl [set ] [number] [status]

Example:

```
LEDCONTROL [set ] [number] [status]
<table>
<thead>
<tr>
<th>set</th>
<th>number</th>
<th>status</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>0 to 16</td>
<td>0 = off</td>
</tr>
<tr>
<td>0</td>
<td>0 to 16</td>
<td>1 = on</td>
</tr>
<tr>
<td>0</td>
<td>0 to 7</td>
<td>2 = flashing</td>
</tr>
</tbody>
</table>
```

The application is defined by the parameters "Set", "Number" and "Status".

"Set" and "Number"

<table>
<thead>
<tr>
<th>Set</th>
<th>Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>0 to 16</td>
</tr>
<tr>
<td>1</td>
<td>0 to 16</td>
</tr>
<tr>
<td>2</td>
<td>0 to 7</td>
</tr>
</tbody>
</table>

The buttons are grouped in "Sets". For the assignment, see section "Parameters (Page 51)."

The "Number" parameter stands for the actuation of the LEDs. "Number" 0 stands for the entire set; 1...16 or 1...7 control individual LEDs.

"Status"

- 0 = off
- 1 = on
- 2 = flashing
Error codes

If an error in the program occurs, an error code is output.

The variable %errorlevel% represents the return value from the program.

<table>
<thead>
<tr>
<th>Description</th>
<th>Outputs on the screen</th>
<th>Output variable %errorlevel%</th>
</tr>
</thead>
<tbody>
<tr>
<td>Driver error</td>
<td>0x20001</td>
<td>131073</td>
</tr>
<tr>
<td>Program errors</td>
<td>0x20002</td>
<td>131074</td>
</tr>
<tr>
<td>Invalid parameter</td>
<td>0x20003</td>
<td>131075</td>
</tr>
</tbody>
</table>

Parameter

Note

The variable "%errorlevel%" represents the value that is returned by the "LEDControl" program.

<table>
<thead>
<tr>
<th>LED designation of keys</th>
<th>LED off set/number/status</th>
<th>LED on set/number/status</th>
<th>LED flashing set/number/status</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>F4; F9..F12; F14; F17..F19; F23..F26; F27..F29</td>
<td>0 0 0</td>
<td>0 0 1</td>
<td>0 0 2  Set 16 bit / Decimal 65535 (-1) (Set 0)</td>
<td></td>
</tr>
<tr>
<td>F1..F3; F5..F8; F13; F20..F22; F33..F36; a/A</td>
<td>1 0 0</td>
<td>1 0 1</td>
<td>1 0 2  Set 16 bit / Decimal 65535 (-1) (Set 1)</td>
<td></td>
</tr>
<tr>
<td>HELP; ACK; F15; F16; F30..F32</td>
<td>2 0 0</td>
<td>2 0 1</td>
<td>2 0 2  Set 8 bit / Decimal 127 (Set 2)</td>
<td></td>
</tr>
<tr>
<td>F1</td>
<td>1 1 0</td>
<td>1 1 1</td>
<td>1 1 2  Set 8 bit / Decimal 127 (Set 2)</td>
<td></td>
</tr>
<tr>
<td>F2</td>
<td>1 6 0</td>
<td>1 6 1</td>
<td>1 6 2  Set 8 bit / Decimal 127 (Set 2)</td>
<td></td>
</tr>
<tr>
<td>F3</td>
<td>1 3 0</td>
<td>1 3 1</td>
<td>1 3 2  Set 8 bit / Decimal 127 (Set 2)</td>
<td></td>
</tr>
<tr>
<td>F4</td>
<td>0 16 0</td>
<td>0 16 1</td>
<td>0 16 2  Set 8 bit / Decimal 127 (Set 2)</td>
<td></td>
</tr>
<tr>
<td>F5</td>
<td>1 8 0</td>
<td>1 8 1</td>
<td>1 8 2  Set 8 bit / Decimal 127 (Set 2)</td>
<td></td>
</tr>
<tr>
<td>F6</td>
<td>1 4 0</td>
<td>1 4 1</td>
<td>1 4 2  Set 8 bit / Decimal 127 (Set 2)</td>
<td></td>
</tr>
<tr>
<td>F7</td>
<td>1 5 0</td>
<td>1 5 1</td>
<td>1 5 2  Set 8 bit / Decimal 127 (Set 2)</td>
<td></td>
</tr>
<tr>
<td>F8</td>
<td>1 2 0</td>
<td>1 2 1</td>
<td>1 2 2  Set 8 bit / Decimal 127 (Set 2)</td>
<td></td>
</tr>
<tr>
<td>F9</td>
<td>0 2 0</td>
<td>0 2 1</td>
<td>0 2 2  Set 8 bit / Decimal 127 (Set 2)</td>
<td></td>
</tr>
<tr>
<td>F10</td>
<td>0 13 0</td>
<td>0 13 1</td>
<td>0 13 2  Set 8 bit / Decimal 127 (Set 2)</td>
<td></td>
</tr>
<tr>
<td>F11</td>
<td>0 4 0</td>
<td>0 4 1</td>
<td>0 4 2  Set 8 bit / Decimal 127 (Set 2)</td>
<td></td>
</tr>
<tr>
<td>F12</td>
<td>0 15 0</td>
<td>0 15 1</td>
<td>0 15 2  Set 8 bit / Decimal 127 (Set 2)</td>
<td></td>
</tr>
<tr>
<td>F13</td>
<td>1 7 0</td>
<td>1 7 1</td>
<td>1 7 2  Set 8 bit / Decimal 127 (Set 2)</td>
<td></td>
</tr>
<tr>
<td>F14</td>
<td>0 12 0</td>
<td>0 12 1</td>
<td>0 12 2  Set 8 bit / Decimal 127 (Set 2)</td>
<td></td>
</tr>
<tr>
<td>F15</td>
<td>2 1 0</td>
<td>2 1 1</td>
<td>2 1 2  Set 8 bit / Decimal 127 (Set 2)</td>
<td></td>
</tr>
</tbody>
</table>
### Software description

#### 3.4 Special touch/key devices

<table>
<thead>
<tr>
<th>LED designation of keys</th>
<th>LED off set/number/status</th>
<th>LED on set/number/status</th>
<th>LED flashing set/number/status</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>F16</td>
<td>2 2 0</td>
<td>2 2 1</td>
<td>2 2 2</td>
<td></td>
</tr>
<tr>
<td>F17</td>
<td>0 6 0</td>
<td>0 6 1</td>
<td>0 6 2</td>
<td></td>
</tr>
<tr>
<td>F18</td>
<td>0 1 0</td>
<td>0 1 1</td>
<td>0 1 2</td>
<td></td>
</tr>
<tr>
<td>F19</td>
<td>0 3 0</td>
<td>0 3 1</td>
<td>0 3 2</td>
<td></td>
</tr>
<tr>
<td>F20</td>
<td>1 15 0</td>
<td>1 15 1</td>
<td>1 15 2</td>
<td></td>
</tr>
<tr>
<td>F21</td>
<td>1 14 0</td>
<td>1 14 1</td>
<td>1 14 2</td>
<td></td>
</tr>
<tr>
<td>F22</td>
<td>1 16 0</td>
<td>1 16 1</td>
<td>1 16 2</td>
<td></td>
</tr>
<tr>
<td>F23</td>
<td>0 11 0</td>
<td>0 11 1</td>
<td>0 11 2</td>
<td></td>
</tr>
<tr>
<td>F24</td>
<td>0 9 0</td>
<td>0 9 1</td>
<td>0 9 2</td>
<td></td>
</tr>
<tr>
<td>F25</td>
<td>0 14 0</td>
<td>0 14 1</td>
<td>0 14 2</td>
<td></td>
</tr>
<tr>
<td>F26</td>
<td>0 10 0</td>
<td>0 10 1</td>
<td>0 10 2</td>
<td></td>
</tr>
<tr>
<td>F27</td>
<td>0 7 0</td>
<td>0 7 1</td>
<td>0 7 2</td>
<td></td>
</tr>
<tr>
<td>F28</td>
<td>0 5 0</td>
<td>0 5 1</td>
<td>0 5 2</td>
<td></td>
</tr>
<tr>
<td>F29</td>
<td>0 8 0</td>
<td>0 8 1</td>
<td>0 8 2</td>
<td></td>
</tr>
<tr>
<td>F30</td>
<td>2 5 0</td>
<td>2 5 1</td>
<td>2 5 2</td>
<td></td>
</tr>
<tr>
<td>F31</td>
<td>2 7 0</td>
<td>2 7 1</td>
<td>2 7 2</td>
<td></td>
</tr>
<tr>
<td>F32</td>
<td>2 6 0</td>
<td>2 6 1</td>
<td>2 6 2</td>
<td></td>
</tr>
<tr>
<td>F33</td>
<td>1 10 0</td>
<td>1 10 1</td>
<td>1 10 2</td>
<td></td>
</tr>
<tr>
<td>F34</td>
<td>1 9 0</td>
<td>1 9 1</td>
<td>1 9 2</td>
<td></td>
</tr>
<tr>
<td>F35</td>
<td>1 12 0</td>
<td>1 12 1</td>
<td>1 12 2</td>
<td></td>
</tr>
<tr>
<td>F36</td>
<td>1 13 0</td>
<td>1 13 1</td>
<td>1 13 2</td>
<td></td>
</tr>
<tr>
<td>HELP</td>
<td>2 4 0</td>
<td>2 4 1</td>
<td>2 4 2</td>
<td></td>
</tr>
<tr>
<td>ACK</td>
<td>2 3 0</td>
<td>2 3 1</td>
<td>2 3 2</td>
<td></td>
</tr>
</tbody>
</table>

#### Examples

**Example: Switch on LED "S16"

```plaintext
#> LEDControl 2 2 1
```

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Explanation of the parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>2 [set]</td>
<td>The LED is in set 2.</td>
</tr>
<tr>
<td>2 [number]</td>
<td>The LED number 2 is set.</td>
</tr>
<tr>
<td>1 [status]</td>
<td>The LED is switched on.</td>
</tr>
</tbody>
</table>
Example: Query status of LED "S16"

`#> LEDControl 2 2`

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Explanation of the parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>2 [set]</td>
<td>The LED is in set 2.</td>
</tr>
<tr>
<td>2 [number]</td>
<td>The LED number 2 is set.</td>
</tr>
<tr>
<td>Status</td>
<td>The status is output in <code>%errorlevel%</code> and displayed as 1.</td>
</tr>
</tbody>
</table>

Note
If the LED flashes a current status cannot be correctly returned. Only the "LED switched on" status can be queries.

Example: Query status of an LED set (16 LEDs)

`#> LEDControl 2`

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Explanation of the parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>2 [set]</td>
<td>The LED set 2 is queried.</td>
</tr>
<tr>
<td>Status</td>
<td>The status is output in <code>%errorlevel%</code>. The value is between 0 and 65535.</td>
</tr>
</tbody>
</table>

Assumption: "F15" and "F16" are switched on. Status of the LEDs: Decimal 3 (F15 ≡ 1, F16 ≡ 2)

Note
If a set consists of 16 LEDs and the status of an LED is shown as binary, 16 bits or 2 bytes are returned. The return value is thus between 0 and 65535 (2^{16} or 0xFFFF).
3.4.1.4 Language selection for key devices

In order to ensure that all characters for key devices are displayed correctly in connection with the KeyTools, the languages for dialogs and keyboard layout must be set to "United States-International".

Note
For SIMATIC IPCs with PhoneKeyPad and installed software, "United States-International" is set.

Procedure

1. Open the "Text Services and Input Languages" dialog.

![Text Services and Input Languages dialog]

2. Under "Default input language" and "Installed services", activate the "United States-International" setting. Significance:
   - "Default input language" defines the dialog language
   - "Installed services" defines the language for the keyboard layout

The table below is a list of all the characters for all keys that are programmed in the table tab15w.pad and in PhoneKeyPad.

In the SIMATIC IPC KeyToolsPhone window under the Open KeyPad menu, you can use the "KeyPads15w.exe" tool to re-program the keys F1 to F36.

The other keys are not programmable.
The table shows the default programming with the factory settings. Whereby the first three lines specify the key function when the PhoneKeyPad is deactivated, and the next two lines show the key function when the PhoneKeyPad is activated.

<table>
<thead>
<tr>
<th>Name</th>
<th>Code (Hex) 0x</th>
<th>Check box</th>
<th>Display/function</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 !</td>
<td>1E</td>
<td>-</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>L Shift/R Shift</td>
<td>!</td>
</tr>
<tr>
<td></td>
<td></td>
<td>R Alt</td>
<td>i</td>
</tr>
<tr>
<td></td>
<td></td>
<td>R Alt + L Shift / R Shift</td>
<td>¹</td>
</tr>
<tr>
<td></td>
<td></td>
<td>PhoneKeyPad</td>
<td>@#%?!&quot;';&lt;&gt;</td>
</tr>
<tr>
<td></td>
<td></td>
<td>PhoneKeyPad + LShift</td>
<td>@#%?!&quot;';&lt;&gt;</td>
</tr>
<tr>
<td>2 @</td>
<td>1F</td>
<td>-</td>
<td>2</td>
</tr>
<tr>
<td></td>
<td></td>
<td>L Shift/R Shift</td>
<td>@</td>
</tr>
<tr>
<td></td>
<td></td>
<td>R Alt</td>
<td>²</td>
</tr>
<tr>
<td></td>
<td></td>
<td>PhoneKeyPad</td>
<td>abc2</td>
</tr>
<tr>
<td></td>
<td></td>
<td>PhoneKeyPad + LShift</td>
<td>ABC2</td>
</tr>
<tr>
<td>3 #</td>
<td>20</td>
<td>-</td>
<td>3</td>
</tr>
<tr>
<td></td>
<td></td>
<td>L Shift/R Shift</td>
<td>#</td>
</tr>
<tr>
<td></td>
<td></td>
<td>R Alt</td>
<td>³</td>
</tr>
<tr>
<td></td>
<td></td>
<td>PhoneKeyPad</td>
<td>def3</td>
</tr>
<tr>
<td></td>
<td></td>
<td>PhoneKeyPad + LShift</td>
<td>DEF3</td>
</tr>
<tr>
<td>4 $</td>
<td>21</td>
<td>-</td>
<td>4</td>
</tr>
<tr>
<td></td>
<td></td>
<td>L Shift/R Shift</td>
<td>$</td>
</tr>
<tr>
<td></td>
<td></td>
<td>R Alt</td>
<td>°</td>
</tr>
<tr>
<td></td>
<td></td>
<td>R Alt + L Shift / R Shift</td>
<td>£</td>
</tr>
<tr>
<td></td>
<td></td>
<td>PhoneKeyPad</td>
<td>ghi4</td>
</tr>
<tr>
<td></td>
<td></td>
<td>PhoneKeyPad + LShift</td>
<td>GHI4</td>
</tr>
<tr>
<td>5 %</td>
<td>22</td>
<td>-</td>
<td>5</td>
</tr>
<tr>
<td></td>
<td></td>
<td>L Shift/R Shift</td>
<td>%</td>
</tr>
<tr>
<td></td>
<td></td>
<td>R Alt</td>
<td>€</td>
</tr>
<tr>
<td></td>
<td></td>
<td>PhoneKeyPad</td>
<td>jkl5</td>
</tr>
<tr>
<td></td>
<td></td>
<td>PhoneKeyPad + LShift</td>
<td>JKL5</td>
</tr>
<tr>
<td>6 ^</td>
<td>23</td>
<td>-</td>
<td>6</td>
</tr>
<tr>
<td></td>
<td></td>
<td>L Shift/R Shift</td>
<td>^</td>
</tr>
<tr>
<td></td>
<td></td>
<td>R Alt</td>
<td>¼</td>
</tr>
<tr>
<td></td>
<td></td>
<td>PhoneKeyPad</td>
<td>mno6</td>
</tr>
<tr>
<td></td>
<td></td>
<td>PhoneKeyPad + LShift</td>
<td>MNO6</td>
</tr>
<tr>
<td>7 &amp;</td>
<td>24</td>
<td>-</td>
<td>7</td>
</tr>
<tr>
<td></td>
<td></td>
<td>L Shift/R Shift</td>
<td>&amp;</td>
</tr>
<tr>
<td></td>
<td></td>
<td>R Alt</td>
<td>½</td>
</tr>
<tr>
<td></td>
<td></td>
<td>PhoneKeyPad</td>
<td>pqls7</td>
</tr>
<tr>
<td></td>
<td></td>
<td>PhoneKeyPad + LShift</td>
<td>PQRS7</td>
</tr>
<tr>
<td>8 *</td>
<td>25</td>
<td>-</td>
<td>8</td>
</tr>
</tbody>
</table>
### 3.4 Special touch/key devices

<table>
<thead>
<tr>
<th>Name</th>
<th>Code (Hex) 0x</th>
<th>Check box</th>
<th>Display/function</th>
</tr>
</thead>
<tbody>
<tr>
<td>L Shift/R Shift</td>
<td></td>
<td>*</td>
<td></td>
</tr>
<tr>
<td>R Alt</td>
<td></td>
<td>¾</td>
<td></td>
</tr>
<tr>
<td>PhoneKeyPad</td>
<td></td>
<td>tvu8</td>
<td></td>
</tr>
<tr>
<td>PhoneKeyPad + LShift</td>
<td></td>
<td>TUV8</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>26</td>
<td>-</td>
<td>9</td>
</tr>
<tr>
<td>L Shift/R Shift</td>
<td></td>
<td>(</td>
<td></td>
</tr>
<tr>
<td>R Alt</td>
<td></td>
<td>’</td>
<td></td>
</tr>
<tr>
<td>PhoneKeyPad</td>
<td></td>
<td>wxyz9</td>
<td></td>
</tr>
<tr>
<td>PhoneKeyPad + LShift</td>
<td></td>
<td>WXYZ9</td>
<td></td>
</tr>
<tr>
<td>0</td>
<td>27</td>
<td>-</td>
<td>0</td>
</tr>
<tr>
<td>L Shift/R Shift</td>
<td></td>
<td>)</td>
<td></td>
</tr>
<tr>
<td>R Alt</td>
<td></td>
<td>’</td>
<td></td>
</tr>
<tr>
<td>PhoneKeyPad</td>
<td></td>
<td>+/-0=0</td>
<td></td>
</tr>
<tr>
<td>PhoneKeyPad + LShift</td>
<td></td>
<td>+/-0=0</td>
<td></td>
</tr>
<tr>
<td>Return</td>
<td>28</td>
<td>-</td>
<td>Return</td>
</tr>
<tr>
<td>Escape</td>
<td>29</td>
<td>-</td>
<td>Escape</td>
</tr>
<tr>
<td>Backspace</td>
<td>2A</td>
<td>-</td>
<td>Backspace</td>
</tr>
<tr>
<td>Tab</td>
<td>2B</td>
<td>-</td>
<td>Tab</td>
</tr>
<tr>
<td>- _ a/A</td>
<td>2D</td>
<td>-</td>
<td>_</td>
</tr>
<tr>
<td>L Shift/R Shift</td>
<td></td>
<td>_</td>
<td></td>
</tr>
<tr>
<td>a/A &amp; PhoneKeyPad</td>
<td></td>
<td>LED off - a, b, c, d, …</td>
<td></td>
</tr>
<tr>
<td>a/A &amp; PhoneKeyPad</td>
<td></td>
<td>LED on - A, B, C, D, …</td>
<td></td>
</tr>
<tr>
<td>. &gt;</td>
<td>37</td>
<td>-</td>
<td>&gt;</td>
</tr>
<tr>
<td>L Shift/R Shift</td>
<td></td>
<td>&gt;</td>
<td></td>
</tr>
<tr>
<td>a/A &amp; PhoneKeyPad</td>
<td></td>
<td>LED off - . ,</td>
<td></td>
</tr>
<tr>
<td>a/A &amp; PhoneKeyPad</td>
<td></td>
<td>LED on - . ,</td>
<td></td>
</tr>
<tr>
<td>DEL</td>
<td>4C</td>
<td>-</td>
<td>Delete</td>
</tr>
<tr>
<td>Page Up / Home</td>
<td>4B</td>
<td>-</td>
<td>Page Up</td>
</tr>
<tr>
<td>Page Down / End</td>
<td>4E</td>
<td>-</td>
<td>Page Down</td>
</tr>
<tr>
<td>Cursor right</td>
<td>4F</td>
<td>-</td>
<td>Right Arrow</td>
</tr>
<tr>
<td>Cursor left</td>
<td>50</td>
<td>-</td>
<td>Left Arrow</td>
</tr>
<tr>
<td>Cursor down</td>
<td>51</td>
<td>-</td>
<td>Down Arrow</td>
</tr>
<tr>
<td>Cursor up</td>
<td>52</td>
<td>-</td>
<td>Up Arrow</td>
</tr>
<tr>
<td>HELP</td>
<td>0B</td>
<td>L Alt</td>
<td>hH &amp; LAlt</td>
</tr>
<tr>
<td>ACK</td>
<td>3A</td>
<td>L Alt</td>
<td>F1 &amp; LAlt</td>
</tr>
<tr>
<td>F1</td>
<td>3A</td>
<td>-</td>
<td>F1</td>
</tr>
<tr>
<td>F2</td>
<td>3B</td>
<td>-</td>
<td>F2</td>
</tr>
<tr>
<td>F3</td>
<td>3C</td>
<td>-</td>
<td>F3</td>
</tr>
<tr>
<td>F4</td>
<td>3D</td>
<td>-</td>
<td>F4</td>
</tr>
<tr>
<td>F5</td>
<td>3E</td>
<td>-</td>
<td>F5</td>
</tr>
<tr>
<td>F6</td>
<td>3F</td>
<td>-</td>
<td>F6</td>
</tr>
</tbody>
</table>
### 3.4 Special touch/key devices

<table>
<thead>
<tr>
<th>Name</th>
<th>Code (Hex) 0x</th>
<th>Check box</th>
<th>Display/function</th>
</tr>
</thead>
<tbody>
<tr>
<td>F7</td>
<td>40</td>
<td>-</td>
<td>F7</td>
</tr>
<tr>
<td>F8</td>
<td>41</td>
<td>-</td>
<td>F8</td>
</tr>
<tr>
<td>F9</td>
<td>42</td>
<td>-</td>
<td>F9</td>
</tr>
<tr>
<td>F10</td>
<td>43</td>
<td>-</td>
<td>F10</td>
</tr>
<tr>
<td>F11</td>
<td>44</td>
<td>-</td>
<td>F11</td>
</tr>
<tr>
<td>F12</td>
<td>45</td>
<td>-</td>
<td>F12</td>
</tr>
<tr>
<td>F13</td>
<td>3A</td>
<td>LSHIFT</td>
<td>F1 &amp; LShift</td>
</tr>
<tr>
<td>F14</td>
<td>3B</td>
<td>LSHIFT</td>
<td>F2 &amp; LShift</td>
</tr>
<tr>
<td>F15</td>
<td>3C</td>
<td>LSHIFT</td>
<td>F3 &amp; LShift</td>
</tr>
<tr>
<td>F16</td>
<td>3D</td>
<td>LSHIFT</td>
<td>F4 &amp; LShift</td>
</tr>
<tr>
<td>F17</td>
<td>3E</td>
<td>LSHIFT</td>
<td>F5 &amp; LShift</td>
</tr>
<tr>
<td>F18</td>
<td>3F</td>
<td>LSHIFT</td>
<td>F6 &amp; LShift</td>
</tr>
<tr>
<td>F19</td>
<td>40</td>
<td>LSHIFT</td>
<td>F7 &amp; LShift</td>
</tr>
<tr>
<td>F20</td>
<td>41</td>
<td>LSHIFT</td>
<td>F8 &amp; LShift</td>
</tr>
<tr>
<td>F21</td>
<td>42</td>
<td>LSHIFT</td>
<td>F9 &amp; LShift</td>
</tr>
<tr>
<td>F22</td>
<td>43</td>
<td>LSHIFT</td>
<td>F10 &amp; LShift</td>
</tr>
<tr>
<td>F23</td>
<td>44</td>
<td>LSHIFT</td>
<td>F11 &amp; LShift</td>
</tr>
<tr>
<td>F24</td>
<td>45</td>
<td>LSHIFT</td>
<td>F12 &amp; LShift</td>
</tr>
<tr>
<td>F25</td>
<td>3A</td>
<td>LCtrl</td>
<td>F1 &amp; LCtrl</td>
</tr>
<tr>
<td>F26</td>
<td>3B</td>
<td>LCtrl</td>
<td>F2 &amp; LCtrl</td>
</tr>
<tr>
<td>F27</td>
<td>3C</td>
<td>LCtrl</td>
<td>F3 &amp; LCtrl</td>
</tr>
<tr>
<td>F28</td>
<td>3D</td>
<td>LCtrl</td>
<td>F4 &amp; LCtrl</td>
</tr>
<tr>
<td>F29</td>
<td>3E</td>
<td>LCtrl</td>
<td>F5 &amp; LCtrl</td>
</tr>
<tr>
<td>F30</td>
<td>3F</td>
<td>LCtrl</td>
<td>F6 &amp; LCtrl</td>
</tr>
<tr>
<td>F31</td>
<td>40</td>
<td>LCtrl</td>
<td>F7 &amp; LCtrl</td>
</tr>
<tr>
<td>F32</td>
<td>41</td>
<td>LCtrl</td>
<td>F8 &amp; LCtrl</td>
</tr>
<tr>
<td>F33</td>
<td>42</td>
<td>LCtrl</td>
<td>F9 &amp; LCtrl</td>
</tr>
<tr>
<td>F34</td>
<td>43</td>
<td>LCtrl</td>
<td>F10 &amp; LCtrl</td>
</tr>
<tr>
<td>F35</td>
<td>44</td>
<td>LCtrl</td>
<td>F11 &amp; LCtrl</td>
</tr>
<tr>
<td>F36</td>
<td>45</td>
<td>LCtrl</td>
<td>F12 &amp; LCtrl</td>
</tr>
<tr>
<td>SHIFT</td>
<td>0</td>
<td>LShift</td>
<td></td>
</tr>
<tr>
<td>ALT</td>
<td>0</td>
<td>LAlt</td>
<td>Alt</td>
</tr>
<tr>
<td>CTRL</td>
<td>0</td>
<td>LCtrl</td>
<td>Ctrl</td>
</tr>
</tbody>
</table>
Software description

3.4 Special touch/key devices

3.4.2 PhoneKeyPad

The alphanumeric input keys of the key devices have the same operating concept as the keypad of a cell phone. Each system key is assigned several letters and special characters of the alphabet and one number.

The "PhoneKeyPad" program provides supports by displaying the character selection with a preview window, which is shown directly below each input field.

The following figure shows an example for a preview window.

![Preview Window Example](image)

Configuring the PhoneKeyPad

Open the PhoneKeyPad using the "PhoneKeyPad" icon in the system tray.

Enabling/disabling the PhoneKeyPad

The "PhoneKeyPad" and "Shift" functions can be enabled and disabled via the shortcut menu of the "PhoneKeyPad" icon in the system tray.

![Shortcut Menu](image)

Functional description

- "disable PhoneKeyPad": Disables the PhoneKeyPad functions. Only the standard keyboard functions are available. The preview feature is disabled.

- "enable PhoneKeyPad": Enables the PhoneKeyPad functions.

- "disable Shift Function": Disables the shift function in combination with the <Home>, <End> and <Ins> keys.

- "enable Shift Function": Enables the shift function in combination with the <Home>, <End> and <Ins> keys.
Technical support

A.1 Service and support

You can find additional information and support for the products described on the Internet at the following addresses:

- Technical support [http://www.siemens.de/automation/csi_en_WW]
- Support request form [http://www.siemens.com/automation/support-request]
- After-sales information system for SIMATIC PC / PG [http://www.siemens.com/asis]
- Industry Mall [http://mall.automation.siemens.com]

When contacting your local representative or Technical Support, please have the following information at hand:

- Order number of the device (MLFB)
- BIOS version (industry PC) or image version (HMI device)
- Installed additional hardware
- Installed additional software

Tools & downloads

Please check regularly if updates and hotfixes are available for download to your device. The downloads are available on the Internet under "After Sales Information System SIMATIC PC/PG" (see above).
Index

C
Clone mode
  Interlocking mechanism, 31, 36
  Security features, 45
Controller version
  Status, 39
Convention
  Style, 3

D
Default Panel PC, 40
Default settings
  Restoring, 38
Driver interfaces
  IOCTL commands, 36

F
Front panel keyboard, 34

H
History, 4

I
IOCTL commands, 36
  IOCTL_ADMIN_TIMEOUT_READ_REG, 37
IPC Keyview, 45
IPC Wizard, 3

K
Key assignment in factory state, 38
Key table
  Status, 39
Keycode table, 39
KeyTools
  LEDControl, 49
  Security features, 45
  Status, 39
  WinCC hotkey, 48

L
LEDControl
  Description, 49
  Examples, 52
  Procedure, 50

M
Modify, 10

O
Operating system requirements, 8
  KeyTools, 8

P
Panel Configuration Center, 14

R
Remove, 10
Repair, 10

S
Screen Saver Settings, 20
Security enables
  Status, 39
Security features
  Security enabled, 45
  SetBrightness, 17
SIMATIC IPC Wizard, 3
Softkeys, 39
Status
  Controller version, 39
  Key table, 39
  Security enabled, 39
  WinCC hotkey enabled, 39
Index

T
Timer mode, 36

U
UPDD, 22

V
Visualization
  IOCTL commands, 36

W
WinCC hotkey, 48
WinCC hotkey enabled
  Status, 39